
Level 3 : Advanced Robotics and Automation

● Learning Outcomes :-
○ Programming in Arduino

○ Magicbit Core associated mini robotic and automated projects

○ Creative hands-on projects using simple craft materials

● Component Kit :- Kit 02
● Lessons Outline

● Time Duration :- 1 - 1.5 hrs per lesson

Lesson Number Lesson Name

01 Automated Fan System

02 Lights Automation System

03 Obstacle avoiding robot car

04 Smart Door Opener

05 Smart Home Device

06 Path Finder Robot (Line follower)

07 Automated Plant Watering System

08 Interactive Pet Toy

09 Garage Parking Assistant

10 Remote Controlled Vehicle

11 Smart Recycling Bin

12 Automated Room Curtains



Magicbit Layout



Magicbit Pinout



Setting Up Magicbit With Arduino

● Download the Arduino Software and install it on the computer

○ https://www.arduino.cc/en/software

● Add the Magicbit to the Arduino IDE

○ Open the Preferences window
■ File -> Preferences

○ Insert the below release link at the “Additional Board Manager”
■ Release Link -

https://github.com/magicbitlk/arduino-esp32/releases/downloa
d/Magicbit/package_magicbit_index.json

https://www.arduino.cc/en/software
https://github.com/magicbitlk/arduino-esp32/releases/download/Magicbit/package_magicbit_index.json
https://github.com/magicbitlk/arduino-esp32/releases/download/Magicbit/package_magicbit_index.json


○ Open the Boards Manager from the Tools Menu.
■ Tools -> Boards -> Boards Manager

○ Search for “Magicbit” and click on “Install”.

● Select the board and port

○ Connect the Magicbit to the computer via USB cable

○ Select the Board
■ Tools -> Boards -> Magicbit -> Magicbit



○ Select the Port
■ Tools -> Port -> COMX

■ If the port doesn’t allow selection / not visible.
● Install the Drivers - https://magicbit.cc/uploader/

https://magicbit.cc/uploader/


Lesson 01 - Automated Fan System

● Activity

○ Automated fan system based on the proximity sensor readings

● Learning Outcomes

○ Arduino Programming

○ Practical application of the concepts

○ Motor Controlling

○ Sensor readings

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Cardboard

○ Proximity Sensor module

○ Fan blade connected DC motor

○ M-F jumper wires

● Steps for the Activity

Expected Output - https://youtu.be/z_0DrhbDgds

○ Step 01(Optional) - Make a simple structure using cardboard which looks
like a table fan stand.

○ Step 02 - Fix the fan blade connected DC motor to the structure as

follows.

https://youtu.be/z_0DrhbDgds


○ Step 03 - Connect the DC motor cables to the Battery (Just to power the

motor ) and see the output.

○ Step 04 - Fix the Proximity sensor module to the above structure as
follows.

○ Step 05 - Instead of just powering the motor, connect the DC motor cables

to the M1 - and M1+ pins or M2- and M2+ pins in the Magicbit.

○ Step 06 - Connect the Proximity IR sensor to the Pin 32 or Pin 33 in the

Magicbit using M-F jumper cables.



○ Step 07 - Open the Arduino IDE and make the below program to control

the Fan ( DC motor) according to the motion detected by the proximity

sensors.

■ Arduino Code -

https://drive.google.com/file/d/1P1s0AqB7Ajjl7EIKN0JhCA1opt-Uou

0y/view?usp=sharing

■ Upload the program and power the set up from the batteries and

test the output while moving the hand towards the proximity sensor.

○ Step 08 - Update the program to control the speed of the motor using the

potentiometer in the Magicbit.

■ Arduino Code -

https://drive.google.com/file/d/1oOG4kk1tbBMvKJuA4uav56uEGxjo

rMLg/view?usp=sharing

https://drive.google.com/file/d/1P1s0AqB7Ajjl7EIKN0JhCA1opt-Uou0y/view?usp=sharing
https://drive.google.com/file/d/1P1s0AqB7Ajjl7EIKN0JhCA1opt-Uou0y/view?usp=sharing
https://drive.google.com/file/d/1oOG4kk1tbBMvKJuA4uav56uEGxjorMLg/view?usp=sharing
https://drive.google.com/file/d/1oOG4kk1tbBMvKJuA4uav56uEGxjorMLg/view?usp=sharing


Lesson 02 - Automated Lights System

● Activity

○ Automated lights system based on the environmental light intensity as well

as when a motion is detected.

● Learning Outcomes

○ Arduino Programming

○ Practical applications of the concept

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ LEDs

○ Resistors (100 ohm)

○ M-M jumper wires

○ Motion (PIR) sensor module

○ Breadboard

● Steps for the Activity

Expected Output - https://youtu.be/dmNpufNRJ9c

○ Step 01 - Make a simple circuit with few LEDs and resistors ( can use

on-board LEDs)

○ Step 02 - Make the program to control the LEDs (ON and OFF) according

to the light level measured by the LDR

https://youtu.be/dmNpufNRJ9c


■ Arduino Code -

https://drive.google.com/file/d/1yQmkfNYkxoWu85upwSvDlwxavjdB

7y98/view?usp=sharing

■ Upload the code and connect the LEDs (circuit with Magicbit) and

power using batteries

○ Step 03 - Update the program to create different patterns according to

different Light Levels.

■ Arduino Code -

https://drive.google.com/file/d/1-K32SjoF4sIZQ8cEQKrvaA6sksAN

MqtZ/view?usp=sharing

○ Step 04 - Update the program to control the LEDs when a motion is

detected while low light intensity in the environment

■ Update the Circuit with PIR sensor

● Connect the PIR sensor to the pin 32 or 33 in the Magicbit

as follows.

■ Arduino Code -

https://drive.google.com/file/d/1Xxy3OO5awdG_84bIBfHI4JanSYZ

YTeph/view?usp=sharing

https://drive.google.com/file/d/1yQmkfNYkxoWu85upwSvDlwxavjdB7y98/view?usp=sharing
https://drive.google.com/file/d/1yQmkfNYkxoWu85upwSvDlwxavjdB7y98/view?usp=sharing
https://drive.google.com/file/d/1-K32SjoF4sIZQ8cEQKrvaA6sksANMqtZ/view?usp=sharing
https://drive.google.com/file/d/1-K32SjoF4sIZQ8cEQKrvaA6sksANMqtZ/view?usp=sharing
https://drive.google.com/file/d/1Xxy3OO5awdG_84bIBfHI4JanSYZYTeph/view?usp=sharing
https://drive.google.com/file/d/1Xxy3OO5awdG_84bIBfHI4JanSYZYTeph/view?usp=sharing


Lesson 03 - Obstacle Avoiding Robot

● Activity

○ Creation of a DIY robot using popsicle sticks to work as an Obstacle

avoiding Robot.

● Learning Outcomes

○ Arduino Programming

○ Advanced motor controlling

○ Robotics Basics

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Popsicle sticks

○ Ultrasonic sensor with cable

○ DC motors

○ Plastic yellow wheels

○ Castor wheel

○ Battery with holder

○ Hot glue gun with glue sticks.

● Steps for the Activity

○ Step 01 - Make the robot as guided below
■ Robot Assembly Guide - https://youtu.be/blH1afLQgMQ

https://youtu.be/blH1afLQgMQ


○ Step 02 - Make the program for the Obstacle Avoiding Robot using

Arduino as follows.

■ Arduino Code -

https://drive.google.com/file/d/1mCaXXB5GjRaSx9yq4GhevAnC5m

1TOpkC/view?usp=sharing

https://drive.google.com/file/d/1mCaXXB5GjRaSx9yq4GhevAnC5m1TOpkC/view?usp=sharing
https://drive.google.com/file/d/1mCaXXB5GjRaSx9yq4GhevAnC5m1TOpkC/view?usp=sharing


Lesson 04 - Smart Door Opener

● Activity

○ Creation of a mechanism to open the door automatically when someone is

detected within the given range.

● Learning Outcomes

○ Arduino Programming - For Loops

○ Servo Motor Controlling

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Cardboard

○ Ultrasonic sensor with cable

○ Servo Motor

● Steps for the Activity

Expected Output - https://youtu.be/d9Upvzx2qxo

○ Step 01 - Create a door structure using cardboard
○ Step 02 - Connect the servo motor to the pin 26 in Magicbit.

○ Step 03 - Make the below program to rotate the servo motor to one

direction

https://youtu.be/d9Upvzx2qxo


■ Arduino Code -

https://drive.google.com/file/d/1mlE4kZAywVfX-R4Os3BjUTmxiRd6i

PqC/view?usp=sharing

○ Step 04 - Update the above program to rotate the servo motor to the

opposite direction as well as at different speeds.

■ Arduino Code -

https://drive.google.com/file/d/1yzi2K2ZoXgtmdaiZn7e7RIlKH18ku

Uep/view?usp=sharing

○ Step 05 - Fix the earlier created door structure with the servo motor and
ultrasonic sensor near to the structure as necessary.

○ Step 06 - Connect theUltrasonic sensor to the magicbit pin 32 or 33 using
jumper cables.

○ Step 07 - Make the program to rotate the servo to different angles (

opening and closing positions of the door ) when an object is detected

within the given range of the door which is measured by the ultrasonic

sensor.

■ Arduino Code -

https://drive.google.com/file/d/15f2Sy-Birr0d6g-bpONwneIGTZb30

QQu/view?usp=sharing

● Try - Try the same activity with PIR motion sensor instead of ultrasonic sensor.

https://drive.google.com/file/d/1mlE4kZAywVfX-R4Os3BjUTmxiRd6iPqC/view?usp=sharing
https://drive.google.com/file/d/1mlE4kZAywVfX-R4Os3BjUTmxiRd6iPqC/view?usp=sharing
https://drive.google.com/file/d/1yzi2K2ZoXgtmdaiZn7e7RIlKH18kuUep/view?usp=sharing
https://drive.google.com/file/d/1yzi2K2ZoXgtmdaiZn7e7RIlKH18kuUep/view?usp=sharing
https://drive.google.com/file/d/15f2Sy-Birr0d6g-bpONwneIGTZb30QQu/view?usp=sharing
https://drive.google.com/file/d/15f2Sy-Birr0d6g-bpONwneIGTZb30QQu/view?usp=sharing


Lesson 05 - Smart Device

● Activity

○ Creation of a mechanism to control the fan and light bulb according to the

temperature within the room which is detected by the DHT11 sensor.

● Learning Outcomes

○ Arduino Programming - Serial printing

○ Sensor readings - DHT11 sensor

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Cardboard

○ DHT11 sensor

○ 10K resistor

○ Fan connected DC motor

○ LED with resistor

● Steps for the Activity

Expected Output - https://youtu.be/RFtnV3Me-v8

○ Step 01 - Connect the DHT11 sensor to pin 33 in the Magicbit .Use the
10K resistor.

https://youtu.be/RFtnV3Me-v8


○ Step 02 - Connect the Magicbit with Arduino IDE and make the below

code to get the readings from the DHT11 sensor .

■ Arduino Code -

https://drive.google.com/file/d/1eaY5UlHd--mOcVfOy7YjLsg2sMOe

2do4/view?usp=sharing

○ Step 03 - Create a simple table fan stand using cardboard.

○ Step 04 - Fix the fan connected DC motor to the above structure

○ Step 05 - Connect the DC motor cables to the M1and M1+ or M2- and

M2+ pins in the Magicbit. Keep the DHT11 sensor connected.

○ Step 06 - Update the earlier program to activate the fan (DC motor)

according to the readings from DHT11 sensor

■ If the temperature is higher than a certain value, turn on the motor.

■ If the temperature is less than the value, turn off the motor.

■ Arduino Code -

https://drive.google.com/file/d/1l5G5X26Qiiw3W1DV6nsWmdrbLdC

jPapR/view?usp=sharing

○ Step 07 - Connect the RGB module to pin 32 in the Magicbit.

https://drive.google.com/file/d/1eaY5UlHd--mOcVfOy7YjLsg2sMOe2do4/view?usp=sharing
https://drive.google.com/file/d/1eaY5UlHd--mOcVfOy7YjLsg2sMOe2do4/view?usp=sharing
https://drive.google.com/file/d/1l5G5X26Qiiw3W1DV6nsWmdrbLdCjPapR/view?usp=sharing
https://drive.google.com/file/d/1l5G5X26Qiiw3W1DV6nsWmdrbLdCjPapR/view?usp=sharing


○ Step 08 - Update the earlier program to indicate the temperature level in

different colors of the RGB

■ High temperatures - RED

■ Middle temperatures - Green

■ Low temperatures - Blue

■ Arduino Code -

https://drive.google.com/file/d/1pXOAaRJuMdeaMvH_fz7PVCCnEA

bCBgos/view?usp=sharing

https://drive.google.com/file/d/1pXOAaRJuMdeaMvH_fz7PVCCnEAbCBgos/view?usp=sharing
https://drive.google.com/file/d/1pXOAaRJuMdeaMvH_fz7PVCCnEAbCBgos/view?usp=sharing


Lesson 06 - Path Finder Robot

● Activity

○ Creation of a DIY robot using popsicle sticks to work as a line follower /

path finder Robot.

● Learning Outcomes

○ Arduino Programming - Serial printing

○ Sensor readings - IR proximity sensor

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Popsicle sticks Robot

○ IR proximity sensor modules

○ Black line track

● Steps for the Activity

○ Step 01 - Assemble the robot (Use the same robot created in obstacle
avoiding robot lesson )

■ Robot Assembly Guide - https://youtu.be/WcdRQHzG7Zg

○ Step 02 - Update the the robot with IR proximity / line tracking sensors

https://youtu.be/WcdRQHzG7Zg


○ Step 03 - Make the program to follow the black line

Arduino Code -

https://drive.google.com/file/d/1Uz5S8qMpkzwmvYNhMuh4c0GYbKX0Sg0n/view?usp=

sharing

○ Step 04 - Make a black track / line on a white surface to test the robot
■ Printable Black Track -

https://drive.google.com/file/d/1hNrdazskvo0TiJwfUG0tOLLoG9YE

Oq5S/view?usp=sharing

Important - This document is scaled to A2 size.

○

https://drive.google.com/file/d/1Uz5S8qMpkzwmvYNhMuh4c0GYbKX0Sg0n/view?usp=sharing
https://drive.google.com/file/d/1Uz5S8qMpkzwmvYNhMuh4c0GYbKX0Sg0n/view?usp=sharing
https://drive.google.com/file/d/1hNrdazskvo0TiJwfUG0tOLLoG9YEOq5S/view?usp=sharing
https://drive.google.com/file/d/1hNrdazskvo0TiJwfUG0tOLLoG9YEOq5S/view?usp=sharing


Lesson 07 - Automated Plant Watering System

● Activity

○ Creation of a DIY setup and a program to water the plants automatically

depending on the plant’s soil moisture level.

● Learning Outcomes

○ Arduino Programming - Serial printing

○ Sensor readings - Soil Moisture sensor

○ Servo Motor operation

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ 2 Popsicle sticks

○ Servo Motor

○ Soil Moisture sensor

○ Saline / Rubber Tube

○ Plant pot / soil sample

○ Mini Plastic bottle - as the water container

○ M-M jumper cables

● Steps for the Activit

○ Step 01 - Make the set up as guided below.
■ https://youtu.be/GRwXbWTSlO8

○ Step 02 - Connect the components with each other according to the below
circuit diagram.

https://youtu.be/GRwXbWTSlO8


○ Step 03 - Make the program to get the readings of the moisture level in

the soil using capacitive soil moisture sensor and decide the threshold

value.

■ Explain about the moisture sensors

● Difference between resistive and capacitive soil moisture

sensors

● Method of getting the readings

■ Arduino Code -

https://drive.google.com/file/d/1l5Dt6ZTt-d-aNmwRQ05X5BKEIHBv

Y-8x/view?usp=sharing

○ Step 04 - Make the program to get the angles of the servo motor which it

should rotate to make the water flow and stop water flow.

■ Arduino Code -

https://drive.google.com/file/d/12M_3H_CE7w5UTXplclKUvmaSN-

QABG7p/view?usp=sharing

○ Step 05 - Make the final program to activate the servo according to the

soil moisture level.

■ Arduino Code -

https://drive.google.com/file/d/1OAIvhSgCos6m5raaf5MXJjPhFld7T

n-f/view?usp=sharing

https://drive.google.com/file/d/1l5Dt6ZTt-d-aNmwRQ05X5BKEIHBvY-8x/view?usp=sharing
https://drive.google.com/file/d/1l5Dt6ZTt-d-aNmwRQ05X5BKEIHBvY-8x/view?usp=sharing
https://drive.google.com/file/d/12M_3H_CE7w5UTXplclKUvmaSN-QABG7p/view?usp=sharing
https://drive.google.com/file/d/12M_3H_CE7w5UTXplclKUvmaSN-QABG7p/view?usp=sharing
https://drive.google.com/file/d/1OAIvhSgCos6m5raaf5MXJjPhFld7Tn-f/view?usp=sharing
https://drive.google.com/file/d/1OAIvhSgCos6m5raaf5MXJjPhFld7Tn-f/view?usp=sharing


Lesson 08 - Interactive Pet Toy

● Activity

○ Creation of a DIY robot pet using cardboard to respond when a person is

detected near it.

● Learning Outcomes

○ Arduino Programming

○ Sensor readings - Ultrasonic sensor

○ LED patterns

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Cardboard

○ DC gear motors x 2

○ Ultrasonic sensor x 1

○ LEDs x 3

○ 100 ohm resistors x 3

○ Mini Breadboard x 1

○ Metal ball castor wheel x 1

○ M-M jumper cables

○ M-F jumper cables

● Steps for the Activity

○ Step 01 - Cut out the sketch of the robot using cardboard
■ Sketch -

https://drive.google.com/file/d/1BcZuAkbwThOpluGiu1VjqJTrvYJJf

CTq/view?usp=sharing

This document is arranged to A3 size.

○ Step 02 - Make the pet robot as in the guided video below.
■ https://youtu.be/7ZdrGHuQFWo

https://drive.google.com/file/d/1BcZuAkbwThOpluGiu1VjqJTrvYJJfCTq/view?usp=sharing
https://drive.google.com/file/d/1BcZuAkbwThOpluGiu1VjqJTrvYJJfCTq/view?usp=sharing
https://youtu.be/7ZdrGHuQFWo


○ Step 03 - Connect the components with Magicbit as in the below diagram

○ Step 04 - Make the program
■ Move the robot forward

■ Detect the people / objects using ultrasonic sensor

■ Rotate / move in circular motion , when a person/ object is detected

■ Activate a pattern in LEDs , when a person/ object is detected

Arduino Code -

https://drive.google.com/file/d/1vBExrmrkvXgIDRG_l4uW8HQbXCAZmJxZ/view?usp=s

haring

https://drive.google.com/file/d/1vBExrmrkvXgIDRG_l4uW8HQbXCAZmJxZ/view?usp=sharing
https://drive.google.com/file/d/1vBExrmrkvXgIDRG_l4uW8HQbXCAZmJxZ/view?usp=sharing


Lesson 09 - Garage Parking Assistant

● Activity

○ Creation of a DIY setup and a program to measure the distance between

the vehicle and the garage wall and indicate it on a display and warning

alarm using a buzzer.

● Learning Outcomes

○ Arduino Programming

○ Sensor readings - Ultrasonic sensor

○ OLED display

○ Buzzer

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Ultrasonic sensor

○ M-F jumper cables

● Steps for the Activity

Expected Output - https://youtu.be/_h_zFK6oVuI

○ Step 01 - Make the arrangement of the components as follows.

https://youtu.be/_h_zFK6oVuI


○ Step 02 - Make the program with following functions

■ Get the distance using ultrasonic sensor

■ Activate and deactivate the buzzer

■ Displaying texts in the OLED display

Arduino Code -

https://drive.google.com/file/d/14vyiWiYhovsMMWg-I0rAteV8xnZn0UTj/view?usp=shari

ng

https://drive.google.com/file/d/14vyiWiYhovsMMWg-I0rAteV8xnZn0UTj/view?usp=sharing
https://drive.google.com/file/d/14vyiWiYhovsMMWg-I0rAteV8xnZn0UTj/view?usp=sharing


Lesson 10 - Remote controlled Vehicle

● Activity

○ Creation of a program to control a DIY robotic car remotely or via

bluetooth.

● Learning Outcomes

○ Arduino Programming

○ Remote controlling

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Popsicle sticks robot car

○ Smart Phone

● Steps for the Activity

Expected Output - https://youtu.be/rUQgRxwqF38

○ Step 01 - Use the robot created in lesson 03 or lesson 06 (Popsicle sticks
robot)

■ Assembly guide - https://youtu.be/WcdRQHzG7Zg

○ Step 02 - Make the program having below functions

■ Receive serial commands via serial monitor

■ Move forward , backward, left , right and stop

Arduino Code -

https://drive.google.com/file/d/1cy5GEEtqd7NKu30FvYErelynAGF9Q0cN/view?u

sp=sharing

■ Upload the code and open the serial monitor and send the given

commands and observe the output

■ Keep the robot connected via USB to the computer

https://youtu.be/rUQgRxwqF38
https://youtu.be/WcdRQHzG7Zg
https://drive.google.com/file/d/1cy5GEEtqd7NKu30FvYErelynAGF9Q0cN/view?usp=sharing
https://drive.google.com/file/d/1cy5GEEtqd7NKu30FvYErelynAGF9Q0cN/view?usp=sharing


○ Step 03 - Update the program to control the robot via mobile app

connected via bluetooth

Arduino Code -
https://drive.google.com/file/d/1b7izzmkcpLgcdAr-r4sN6fiVY00D3PhI/view?
usp=sharing

■ Upload the code to the robot (Magicbit)

■ Power the robot using batteries

■ Download any bluetooth remote controlling app to the mobile phone

● Eg - Arduino Bluetooth Control

■ Turn On the bluetooth in the smartphone

■ Search for the device which you gave for the robot in the above

code and pair with it.

● In the above code it is “MagicbitRobot”.

■ Open the previously downloaded mobile app and connect with the

same device name as above.

■ Select the option “Use as a gamepad or car controller” if available.

■ Now control the car accordingly.

https://drive.google.com/file/d/1b7izzmkcpLgcdAr-r4sN6fiVY00D3PhI/view?usp=sharing
https://drive.google.com/file/d/1b7izzmkcpLgcdAr-r4sN6fiVY00D3PhI/view?usp=sharing


Lesson 11 - Smart Recycling Bin

● Activity

○ Creation of a program to detect the garbage level inside a dustbin and

indicate it via Color LEDs (RGB)

● Learning Outcomes

○ Arduino Programming

○ Neopixels controlling

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Styrofoam cup

○ Ultrasonic sensor

○ Neopixel LED

○ Battery with holder

○ M-F jumper cables

○ Piece of carboard

● Steps for the Activity

Expected Output - https://youtu.be/G7I3vBCc0rM

○ Step 01
■ Make the dustbin using a styrofoam cup and a lid for that using the

piece of cardboard.

■ Attach the other components and connect them as in the diagram

below.

https://youtu.be/G7I3vBCc0rM


○ Step 02 - Make the code with following functions
■ Measure the distance using ultrasonic sensor

■ Switch the colors in neopixel LED according to different distance

ranges

Arduino Code -

https://drive.google.com/file/d/1O3l9FEJLVsxCBg4aQpRU5oSGGVp-JYt6/

view?usp=sharing

○ Step 03 - Update the above program to display the measured distance on

the Magicbit Display .

■ Arduino Code -

https://drive.google.com/file/d/1N7s2TAjCly8Bv_28Pk0mQj6l3vvCs

CsY/view?usp=sharing

https://drive.google.com/file/d/1O3l9FEJLVsxCBg4aQpRU5oSGGVp-JYt6/view?usp=sharing
https://drive.google.com/file/d/1O3l9FEJLVsxCBg4aQpRU5oSGGVp-JYt6/view?usp=sharing
https://drive.google.com/file/d/1N7s2TAjCly8Bv_28Pk0mQj6l3vvCsCsY/view?usp=sharing
https://drive.google.com/file/d/1N7s2TAjCly8Bv_28Pk0mQj6l3vvCsCsY/view?usp=sharing


Lesson 12 - Automated Room curtains

● Activity

○ Creation of a program to fold and unfold the room curtains according to

the light level in the room.

● Learning Outcomes

○ Arduino Programming - switch case

○ Sensor readings - LDR

○ DC motor controlling

● Materials Required

○ Magicbit Core

○ USB cable

○ Computer with Arduino IDE

○ Yellow gear Motor

○ Plastic pen tubes

○ Cardboard

○ Hot glue gun with sticks / Double tape

● Steps for the Activity

Expected Output - https://youtu.be/FKSrVIKp7dg

○ Step 01 - Make the set up as below ( Example set-up of a curtain)

■ Take a piece of cardboard with the size 8 x 15 cm (Hereyou can

use a piece of cloth or tissues )

https://youtu.be/FKSrVIKp7dg


■ Remove one ply of the above piece to make it more flexible.

■ Attach the both ends to the pen rods using hot glue or double tape

■ Fix one pen rod to the DC gear motor shaft and connect the motor

to the magicbit M1 or M2 pins.



○ Step 02 - Make the code with following functions
■ Get the readings from LDR in the Magicbit

■ Rotate the motor to forward, backward and stop directions.

■ Control the motor’s rotation according to the LDR readings.

Arduino Code -

https://drive.google.com/file/d/1VPMYxVzVI4tp4-_o-6VGsR76UVTx20-q/view?usp=shar

ing

https://drive.google.com/file/d/1VPMYxVzVI4tp4-_o-6VGsR76UVTx20-q/view?usp=sharing
https://drive.google.com/file/d/1VPMYxVzVI4tp4-_o-6VGsR76UVTx20-q/view?usp=sharing

